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Preface  
 

In this workshop, you will gain an overview of the Terrain Modeling tools available at V8i 
SELECTseries 3 through the Civil environment.  We have structured the contents of the exercises to 
provide a broad spread coverage of the tools; however, we will not use every tool.  The objective for 
this workshop is to provide examples that you can apply real-life context towards to facilitate utilizing 
them in your own engineering projects. 

This workshop does not cover the Survey tools previously known at SELECTseries 2 as Data 
Acquisition.  Data Acquisition processes essentially remain at SELECTseries 3 as two discrete packages 
- Survey and Terrain Modeling. While these survey tools have been enhanced over SELECTseries 2 
Data Acquisition capability the processes essentially remain as before for creating a survey, the main 
difference being the creation of a Civil Terrain model. 

This workshop is equally applicable for the MX, InRoads or GEOPAK families of products.  Each 
product contains identical toolsets and workflows.  The only differences between the three products 
for the tools are slight differences in the use of feature definitions and some differences in the back-
end interaction with other native toolsets, such as drainage.  In this workshop, we will use Power 
InRoads, Power GEOPAK or MX (your choice) V8i 08.11.09.xxx. 

In each Chapters opening DGN file, there will be text entitled with the chapter number and a “How – 
To” link.  Right clicking on this text will show an option for “Open Link”.  This will allow a student 
whom may be struggling with a particular exercise the ability to watch the video to see how the steps 
were performed.  The video will have audio, so you should mute your computer before viewing.  It is 
encouraged to only watch the videos as a last resort or to review them upon completion of the 
exercise to compare your results. 

In order for all participants to design the same layout and to stay on course and on time, we request 
that all participants utilize the files as listed in the workshop materials.  At the beginning of each 
chapter, we will start with a fresh set of data.  This ensures that everyone is using the same data. 

The workshop guide is yours to take with you.  If you don’t finish all the exercises, or just want to 
work with the dataset upon return to your office, the datasets (both initial and completed files) are 
provided on the Conference DVD.  Many workshops will also have videos of all exercises on the DVD.   

Note Prerequisite Knowledge Level: Participant should have a basic understanding of 
terrain modeling principles and be fluent in the use of one of the Bentley 
Power products or CAD and the native application (MX, InRoads or GEOPAK).  
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Chapter 1: MicroStation Terrain 
Element 

OVERVIEW 
SELECTseries 3 MicroStation provides a Terrain Model Element type and supports creation by 
importing LandXML, general display controls and provides tools to allow labeling of contours and 
spots elevations. Bentley Civil extends the available tools to provide the additional creation, edit and 
analyze functionality needed to create suitable terrains for the complex workflows needed through 
subsequent design processes. 

The intent of this exercise is to help the designer better understand the core tools available in 
MicroStation SELECTseries 3 since terrain models are the starting base for all infrastructure and form 
a critical part of the design process for everything we build.  

 

PROJECT DESCRIPTION 
In this workshop we will be completing basic steps that can be applied to many different scenarios.  
The intention here is to give an overview of the Terrain Element and the tools available that will be of 
benefit in many of the other technology workshops.   

Project Steps 
1. Confirm setup 
1. MicroStation Terrain Model Element 

i. Element Templates 
ii. Display Controls 

iii. Annotation tools 

GETTING STARTED 
As we begin today’s workshop, let’s do some quick checks to be sure your workstation / laptop is 
ready to go. We have preloaded the workshop files and settings in order to save set-up time.   

 Exercise: Check Workshop / Laptop Settings 

Exercise Objective:  Open the correct design file selecting the proper user configuration file.   

Procedure: 

1. Use the provided login and password to access your laptop if not previously logged in. 
2. Your instructor will provide you the path to the workshop dataset.  Select either the Power 

InRoads, Power GEOPAK or MX icon on your desktop.  In the File Manager dialog, set the 
User to BC3WK2 - Technology Preview Workshop - Terrain Modeling. 

3. Open the file Chapter 1 - Import.dgn 
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4. Select Workspace > Configuration from the main menu bar. 
5. Scroll down and click the variable MS_DGNLibList and ensure the workshop path is 

included as one of the listings.  If it is not listed, please advise the instructor. 

CREATING A TERRAIN MODEL 

 Exercise: Import from file - LandXML 

Exercise Objective:  Import a LandXML Terrain Model  

Terrain Model Tool Used:  

MICROSTATION TERRAIN MODEL TASKS ICON TOOL 

  
Import LandXML Terrain Model 

Note If you are running one of the Civil Products you can access the same options 
under the main menu > Tools > Terrain model – just open as a toolbar to 
simulate the core MicroStation tools 

Procedure: 

1. Remain in the file Chapter 1 - Import.dgn. 
2. Select Import LandXML Terrain Model command Terrain Model Tasks.  
3. Select Chapter 1 – LandXML\survey.xml 
4. For now Leave the Element Template as None and Import to display the Ground Terrain 

using the default display mode. 

 
MicroStation LandXML Import 

 

Note Element Templates control default display styles and we’ll explore these in 
detail shortly. 
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5. Select the terrain and open Element Info so we can familiarize ourselves with the elements 
properties and display controls. 
 

 
MicroStation Terrain Element Info 

TERRAIN MODEL DISPLAY STYLES  

 Exercise: Controlling the Terrain model display 

Exercise Objective:  Apply Element Template and modify the style  

Procedure: 

1. Element Info – General. Select template – Terrain\Existing Ground to apply a predefined 
display style that is available through loaded DGNlibs or the active drawing. 

2. Select from the MicroStation main menu > Element > Element Template and open the 
Existing Ground style. 

3. Change the Calculated Feature Settings > Contours. 
i. Major interval to 10 

ii. Minor interval to 1 
Changes to the Element template are instantly reflected in the display for anything using the 
style 

4. Create a new Element Template, name it ‘All properties’, RHM to active the menu > Add > 
Terrain Model > All. 
Here we have all the MicroStation controls to define deployable drawing standards. 
Take a moment to explore the available settings, try activating the new style as the current 
Element Template for the Ground Terrain model. 
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MicroStation Element Templates 

TERRAIN MODEL DISPLAY CONTROLS 

 Exercise: Modify local display properties 

Exercise Objective:  Locally adjust style the active Terrains display style  

Procedure: 

1. Element Info – General. Select template – Terrain\Existing Ground. 
2. Element Info – Selection, navigate and select contours to investigate the options. 

 

 
MicroStation Element Information 

Note Try setting a minor contour interval of 0.05 and smoothing of Spline. Consider 
the implication of this level of display setting 

Hint Undo and redo work on these changes  



DGN Display Styles 

 

Workshop:  Workshop – X5 - Terrain Modeling  13 
Copyright © 2012 Bentley Systems, Inc. 

DGN DISPLAY STYLES 

 Exercise: Use MicroStation Display Styles 

Exercise Objective:  Locally adjust style the active Terrains display style  

Procedure: 

1. Element Info – General. Select template – Terrain\Elevation Theme 
This Element Template has been predefined to turn on thematic height shading for the 
current view.  Shading and lighting are particularly helpful in identifying problems in the 
terrain.  

2. From the Main Menu Select > Settings Element – Display Styles to review Element Info and 
settings applied in the Template\Elevation Theme 

Note The Thematic Display Styles work on any mesh object not just Terrain models. 
To toggle the model on ensure the Triangles are displayed. By default four 
thematic maps are supplied – Height, Slope, Aspect and Hill 

 
 

 
MicroStation Thematic Display Styles 

DISPLAY OVERRIDE AND CONTOUR ANNOTATION 

 Exercise: Use MicroStation Display Overrides and Terrain Annotation Options 

Exercise Objective:  Produce a sheet drawing with Terrain specific annotation  

Procedure: 

1. Ensure the Terrains active Template is Elevation Theme. 
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2. Select the MicroStation Sheet model – Simple Drawing. 
This Drawing display the terrain model in the same style as is active in the design model. 

3. Select the Terrain and open Element Information. 
4. Enable Override Symbology. 
5. Select the Terrain and pick Template\Existing Ground. 

Note With Override Symbology in place we can change the element template and 
display properties to suit the drawing use case. 

6. Apply the Saved View – Depression Contour. 
7. Select from the Terrain Tasks - Label Terrain Contour. 

This MicroStation tool allows manual annotation in areas of specific interest. 
8. Ensure the Terrain Model GROUND is active. 
9. Use the annotation tool to apply specific annotation. 

Hint Use the following settings and apply by using a crossing line. 

 
MicroStation Thematic Display Styles 

Note Both Label Terrain Contours and Spots require pre-selection of the Terrain. 

CHAPTER SUMMARY 
In this chapter, we have been introduced to the MicroStation Terrain Model element, its properties 
and display controls. These options are available to all users of MicroStation V8i SELECTseries 3 and 
beyond. 
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Chapter 2: Create from File  
OVERVIEW 

In this and subsequent sections, we will look at a selection of the tools and benefits extended to 
Terrain Models when a Civil product is present. We do not have time to cover all the options, but 
intend to cover common options and take the time to highlight benefits with a variety of workflows. 

Note The Civil product adds a level of intelligence to file import option and preserves links to 
the source data files – relative, full and Projectwise paths are supported. This ability allows 
the Civil Terrain Element to receive updates / revisions to the base data and preserves the 
integrity of relationships built with the model.  

CIVIL TERRAIN MODEL – CREATE FROM FILE 

 Exercise: Create a Civil Terrain from a external files 

Exercise Objective:  .Familiarize the import from file dialog and options 

All Terrain Tasks can be located from MicroStation Tasks > Civil Tools > Terrain Modeling 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  Create from File 

Procedure: 

1. Open the file Chapter 2\Import from file.dgn. 
2. Open Terrain Model Task – Create from File. 

Hint Files by type gives us a full listing of the supported file formats 
including the native Civil product main file Tin, dtm and .fil. The general 
process is the same for these formats 

3. Select Chapter 2\LandXML\Main Survey.xml  
The XML we are importing contains the name definition for the resulting surface in the left 
hand side. If you want to rename the surface, click on the name. 

4. Set the Feature definition to Terrain\General Terrain 

Note This is the surface type and contains a link to the Element template that defines 
the style. Feature definitions are covered in the Moving to SELECTseries 3 
workshops.  
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5. Set the Edge Method to No removal. 

 
Import Terrain Tiff Settings 

6. Import , close the form and fit the view. 
7. Take time to review the available display properties using the Context Toolbar Display 

Properties 

Hint Select the terrain element and hover on it to active the toolbar. The 
options available vary according to the element type 

 
Context Toolbar display properties 

UPDATING A CIVIL TERRAIN MODEL 

 Exercise: Update Terrain Source Rule 

Exercise Objective:  .Update the stored terrain model by activating the associated rule  

Warning The rule is only created and available for update when in a Civil 
product 

Procedure: 

1. Open a Windows Explorer view to \Chapter 2\LandXML and run update.bat (Simulating a 
file revision from Projectwise) 

2. Open Project Explorer and view the Civil model tab. 
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3. Expand the Terrain Model’s tree to allow review the stored terrain model. 

Note The path is relative but resolves locally to show the full path or Projectwise 
path. 

4. Right Click on the Rule  ‘From file:…’ and Select ‘Update Terrain Source’. 

 
Update Terrain from File Rule 

 

CHAPTER SUMMARY 
In this chapter, we have been introduced to the extended Civil Terrain import file options, the 
concepts of Terrain Feature Definitions and Terrain Rules for updating terrains created from external 
sources or bulk imports. 
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Chapter 3: Reviewing Terrain Models 
OVERVIEW 

In this section, we’ll look at a selection of the review and editing tools extended to Terrain Models 
when a Civil product is present. We do not have time to cover all the options, but intend to cover 
common options and take the time to highlight benefits with practical workflows. 

REVIEWING TERRAIN MODELS 

 Exercise: Reviewing the imported Terrain  

Exercise Objective:  Identify and resolve errors in the supplied Survey  

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

 

 

 

 

 

Report Crossing Features 

Report Conflicting Points 

Edit Terrain Model 

Analyze Point 

Procedure: 

1. Open the file Chapter 3 – Reviewing Terrains.dgn. 

Hint Visual inspection – use the various view modes to try and identify any 
problems, try the height banding option, contours etc to see if there 
are any gross errors 

2. Open the command Report Conflicting Points  
3. Follow the heads-up prompts.   

HEADS-UP PROMPT USER ACTION 

Select Terrain Model  
Element 

Select the Terrain SURVEY 

Apply Level Tolerance Select No (up / down keys) 

Set Level Tolerance Data point in the Display 

4. In the Terrain Model Report Dialog we have a duplicate point listed. The active point is 
indicated as – Terrain Point 

5. Right Click  on one of the warnings in the table and select ‘zoom to’ 
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6. To help understand the terrain the command Analyze Point  can be used to locally 
investigate the surface  

Hint This tool provides dynamic tooltip information and contour trace 
through the cursor location for the current surface. The graphics can 
be saved to a 3D linestring in the graphics using the current style if 
required. 

7. Right Click on the active Terrain point and Delete. This will force use of the higher value and 
smooth the resulting terrain. 

 
Update Terrain from File Rule 

 

8. Open the command Report Crossing Features  
9. Follow the heads-up prompts.   

HEADS-UP PROMPT USER ACTION 

Select Terrain Model  
Element 

Select the Terrain SURVEY 

Apply Level Tolerance Select YES (up / down keys) 

Set Level Tolerance Enter a value of 0.5 

 Data point in the Display 

Note We’re only looking for gross errors here so have set the tolerance higher than 
normal. This report can be run at any time with appropriate settings to refine 
the model 

10. In the resulting table view, select the ‘Level Difference’ Header to sort the view and review 
the identified issues. 

11. Open Saved View 2 - .(the bridge area in the middle of main view) 
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12. Turn on the ‘Source Feature Display’ – breaklines. This will help understanding the problem 
with the Terrain. 

  
Update Crossing Features  

13. Resolve the errors resulting from the inclusion in the surface of the three parallel break line 
that represent the road surface on a bridge (level difference over 2m) using the right click 
option Delete Feature. Remember to use undo if unsure 

14. Open Saved view 3 
15. Turn on ‘Breaklines’, ‘Spots’ and ‘Triangles’ to aid the  

Hint You can modify the spots style to add a cell or text by exploring the 
element information selection tree view. 

16. Open the command Edit Terrain Model  
17. Explore options to improve contours by swapping triangle faces  

 
Update Crossing Features  

Hint If time allows use the edit options to tidy up the edges of the terrain 
and remove unwanted triangles 

 

CHAPTER SUMMARY 
In this chapter, we have been introduced to the extended Civil Terrain review options. We have been 
looking at these in relation to solving problems with externally supplied files at a terrain level without 
introducing the linear / point features; these will be covered in later chapters. 
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Chapter 4: Appending Terrain Models 
and Create from ASCII  

OVERVIEW 
In this section, we continue to look the available options for creating Terrain Models from multiple 
sources and consider append / merge. The intension is to give an overview of the options so you can 
establish workflows that suit your practices. We do not have time to cover all options in detail but 
will cover the more common data formats. 

 

Exercise Objective:  Create individual Terrain Models for the various data sources and append 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  

 

Create from File 

Create from ASCII 

APPENDING A TERRAIN MODEL FROM FILE  

 Exercise: Appending to a terrain 

Exercise Objective:  Append terrains together 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  Create from File 

Procedure: 

1. Open the file Chapter 4 – Import from File.dgn. 

2. Create from File  
3. Select the files .\Chapter 4\LandXML\ Phase1 & 2. 
4. We can use the Dialog to process multiple files, either to individual Terrain Models  in the 

current DGN or by running the command in sequence and appending them together. 
5. Unselect Survey Phase 2 as we will be processing the files seperately. 
6. Change the name of Survey Phase 1 to Survey. 
7. Set the Feature definition to Terrain\General Terrain. 
8. Import and fit View. 
9. Select Survey Phase 2. 



Appending a Terrain Model from ASCII File 
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10. Toggle Append to Existing Terrain and pick Survey before importing. 

Warning Append if you know the format, if unsure create separate Terrains and 
create a Complex Terrain – covered in subsequent Chapter. 

  
Append on Import from file 

11. Select the resulting terrain and open Element information to confirm the following surface 
infromation. 

 
Append on Import from file 

APPENDING A TERRAIN MODEL FROM ASCII FILE  

 Exercise: Appending to a terrain 

Exercise Objective:  Append terrains together 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  
Create from ASCII 

 

Procedure: 

1. Select Create Terrain from ASCII Import  
2. Select \ASCII\SPOTS.txt 
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We need to load an existing mapping file or create a new one.  
3. Use the Text Import Wizard browse button to load the saved settings file Chapter 

4\ASCII\Spot import settings file.xml  
4. Select Edit Settings file from the icons to review them. 
5. Edit the Settings file to review the formatting is correct 

 
Text File Import - File Format Settings 

Hint Ensure the file header is ignored by starting the file at line 4. 

 
Text File Import - Column Format Settings 

 

Hint Ensure the Feature Type is set to SPOT. 
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Text File Import - Filters Settings 

Note If we have multiple codes and formats that we need to cater for filters are 
required, in this case we just have a single feature type. 

6. Finish the Text Import Settings and save  a new settings file with any changes 
7. Toggle Append to Existing Terrain and pick Survey before importing 

 
ASCII File Import  

8. Select the resulting terrain and open Element information to note the changes to surface 
from before. 
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CHAPTER SUMMARY 
In this chapter, we have been introduced to the processes behind multiple imports from file, 
appending terrains and defining a custom import from an ASCII file.  
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Chapter 5: Create Terrain from 
Graphical Elements 

OVERVIEW 
In this section, we will learn the steps associated with using bulk import options to create Terrain 
Models from graphical information. The automated processes applied used with bulk import 
methods provide deployable standards to simplify date import. We will also look at the associated 
manual creation process and the difference in the resulting models. 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  

 

 

 

Create from Elements  

Add Features 

Create by Graphical Filters  

Graphical Filter Manager  

CREATING TERRAIN MODEL BY GRAPHICAL FILTERS (BULK IMPORT) 

 Exercise: Creating Terrain models by Graphical Filters 

Exercise Objective:  Create Terrain Model from stored graphics 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  
Create Terrain by Graphical Filters 

Procedure: 

1. Open Chapter 5 – Import from Graphics.dgn. 

2. Select the Terrain Modeling task Create Terrain by Graphical Filters  
3. Select  Graphical Filter Group – Bulk Import from Graphics and preview 

Note The filter is stored in a DGNlib and can be viewed in Project Explorer; to use 
and edit a local copy is created when it is selected. 

4. In the form Ensure the following settings  
i. Edge Method = Remove Slivers 

ii. Terrain Features  Feature Definition = General Terrain 
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iii. Name Prefix = Survey 

 
Graphical Filter Managers 

5. Follow the on screen prompts to confirm and accept the import. 

CREATING GRAPHICAL FILTERS  

 Exercise: Creating Graphical Filters 

Exercise Objective:  Create a new Graphical Filter 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  
Graphical Filter Manager 

1. Select Graphical Filter Manager  
2. Expand the tree view to review the stored Filters and Filter Groups. 

 
Graphical Filter Managers 

3. In Level Display – Enable the level Spot Height 
4. Zoom in and select a point In the drawing select an element representing the Spot features 

- Ref3:Surevey Phase3 Ground model 

5. In the Graphical Filter Manager select Create Filter by Selection Set   



Adding Elements to a Terrain Model 
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Edit Filter allows you to review all the display properties for the current Selection. These 
filters properties can be wild card or explicit based on multiple properties. 

6. Preview to ensure all the random spots are selected before Finish. 

Hint Clear the current Selection in the drawing before trying the preview  

 
Graphical Filter Manager 

 
7. Under Filter Properties enter Name = Random Spots 
8. Feature Type = Spot 
9. Select the Graphical Filter Group – Bulk Import from Graphics 
10. Add the newly created Random Spots filter and Finish. 
11. In Project Explorer for the Survey Update Terrain Source 

 
Project Explorer – Update Terrain Source 

ADDING ELEMENTS TO A TERRAIN MODEL  

 Exercise: Manually adding graphical elements into Terrain models 

Exercise Objective:  Manually add features to an existing terrain 

Procedure: 

1. Select all the elements on the level Buildings 
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Hint Use Level display to help isolate the building level 

2. Select Terrain Task – Add Features  
3. Select Survey as the Terrain model 
4. Select Void as the feature type 

 

 
Create From Elements 

Note Voids need to be closed shapes, try moving a building to see what happens -  

5. Accept the command to add the buildings as voids. 
6. Zoom into one of the buildings to confirm it has no triangles crossing it. 

Note Elements added in this way are ruled and so the terrain updates automatically 
if they are moved. This rule is available on the bulk import options but as it’s 
bulk import we typically would use the bulk rule and so set the option ‘Do not 
link Elements’. 

CHAPTER SUMMARY 
In this chapter, we have been introduced to several possible creation methods, from simple elements 
to automated bulk import. Individual elements added from the graphics are ruled directly to the 
terrain, so if you make changes to the element the Terrain automatically updates, this dynamic 
updating is useful with site design type scenarios where the design elements are combined into 
Terrains with surface and linear templates. Bulk import creates a rule that can be manually updated 
to refresh the Terrain. 
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Chapter 6: Create from Point Cloud 
OVERVIEW 

In this section, we look at the processes involved in creating a terrain from a simple point cloud.  

Note To aid in importing the required information the Terrain from Point Cloud supports 
selection by classification and fence selection. In this instance we’ll simply bring in the 
entire scan. 

CREATING A TERRAIN MODEL BY POINT CLOUD 

 Exercise: Creating Terrain models from a Point Cloud 

Exercise Objective:  Append to an existing terrain graphical elements 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  Create from Point Cloud 

Procedure: 

1. Open Chapter6\Point Cloud.dgn  
The point cloud has already been attached. Take a moment to review the View Attributes 
to look at the point cloud. 

2. Select the Terrain Model task Create by Point Cloud  
3. Before testing the Filter Select  

• Filter method as Tin,  
• Z Tolerance of 0.1  
• Granularity of Fine  

The method of filtering and settings depends on the scans resolution, in this case we’re 
using an artificial surface created to represent a scan and so due to its uniform surface it 
returns a high reduction factor. 

4. Select the Feature as Large Terrain (to display just as the Terrain Boundary) 
5. Set Edge Method to Remove Slivers and Import. 
6. Turn on Contours for the resulting Terrain to validate the surface.  
7. Turn off the Point Cloud’s display under File > Point Clouds. 
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ANALYZE VOLUMES  

 Exercise: Analyze Volumes from multiple Terrain Models  

Exercise Objective:  Report volumes between two terrain models 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

 

 Analyze Volumes 

Procedure: 

1. Open Chapter6\Volumes.dgn  

2. Select the Terrain Model task Create Analyze Volumes  
3. Follow the heads-up prompts.   

 

HEADS-UP PROMPT USER ACTION 

Volume Method Terrain Model to Terrain Model Volume 

Locate From Terrain Model Enter Survey 

Locate From Terrain Model Enter Point Cloud DTM 

Cut and Fill Factors Enter 1 

Boundary Reset for no boundary 

Save Results Yes 

 

Hint A delta terrain between surfaces could be created and stored if an 
Isopach contour map is required  

 

CHAPTER SUMMARY 
In this chapter, we have been introduced to Point Cloud and analysis methods for extracting 
volumetric information from multiple Terrain models. 
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Chapter 7: Creating a Complex 
Terrain Model  

OVERVIEW 
In this section, we look at the processes involved in combining surfaces into a complex terrain model.  

CREATING A COMPLEX TERRAIN MODEL 

 Exercise: Creating a Complex Terrain Model 

Exercise Objective:  Gain an overview of the complex terrain options for merge and append 

Terrain Model Tool Used:  

TERRAIN MODEL PANEL ICON TOOL 

  
Create Complex Terrain Model  

 

Procedure: 

1. Open Chapter 7\Complex Terrain.dgn 
2. Select the Terrain Model command Create Complex Terrain Model. 
3. Add the models and the method as indicated below. 

• Survey Phase 1 – Primary 
• Survey Phase 2 – Append 
• Survey Phase 3 – Append 
• Point Cloud DTM - Merge 

Note Order and method are important and needs to be given some thought as the 
wrong order and or processes will yield different results. When appending, the 
software triangulates the combined data from the two terrain models using all 
data from both models and ignoring none. The two models may overlap or be 
adjacent to one another. If there is data in both models in a common area, it is 
all utilized for triangulation. The Merge function uses the boundary of the 
merge surface to clip out current data and replaces it with the merge surface. 

4. Set the Feature Definition to Existing Terrain. 
5. Set Name Prefix to Ground. 
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Complex Terrain 

6. Apply and inspect the finished terrain. 

Hint If you get the order or method wrong or need to add more terrain 
models, further editing of the Complex Terrain can be accessed from 
the quick properties or Element Information. 

 

CHAPTER SUMMARY 
In this chapter, we have been introduced to Complex Terrain Model creation methods and options 
for file management.  
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Chapter 8: Clipping Terrains to 
Corridors 

OVERVIEW 
In this section, we will look the processes involved in clipping terrains. 

CLIPPING A TERRAIN MODEL TO A CORRIDOR 

 Exercise: Clipping Terrain to Corridor Objects 

Exercise Objective:  Understand the process of clipping 

Terrain Model Tool Used: Create Clipped Terrain 

TERRAIN MODEL PANEL ICON TOOL 

  
Create Clipped Terrain Model 

Procedure: 

1. Open Chapter 8\Clipped.dgn 
The model is made up of the following references 

• Corridors 
• Complex Terrain 

2. Select the Terrain Model command Create Clipped Terrain Model. 
3. Follow the heads-up prompts.   

HEADS-UP PROMPT USER ACTION 

Locate Reference Terrain 
Model Element 

Select the Terrain Model Ground 

Locate Clipping Element Select The Primary Route Corridor 

Locate Next Clipping Element Select The Access Track Corridor 

Clipping Method Internal 

Horizontal and Vertical Offsets  Enter 0 

Feature Definition Proposed Terrain 

Name Prefix Enter Clipped Terrain 

 Data Point to accept 

Note The Clipped Terrain is ruled to the corridor, so as the corridor updates so does 
the Clipped Terrain. 
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CHAPTER SUMMARY 
In this chapter, we have been introduced to the concept of Clipping Terrain Models. These clipped 
Terrain Models are ruled to the elements that clip them and refresh as the model is accessed.  

This page left intentionally blank.  
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Appendices 
 

TERRAIN MODEL FEATURES 
The concept of feature types is used throughout the Terrain Model tools. 

Spot or Spot 
Elevation 

Points (with X,Y,Z data) that have no functional relationship to any other 
point. Random survey shots in open terrain would be an example of 
random spots. Point elements such as cells, circles, and text strings are 
typical MicroStation elements used to graphically define spot elevations. 
Lines, line strings, and other longitudinal elements are equally valid. The 
software creates a spot elevation for each vertex of each longitudinal 
element. 

Break Line 

Breaks are used to designate linear features such as edges of pavement, 
ditch bottoms, ridges, etc. where an abrupt change of slope occurs. Any 
longitudinal element may be defined as a break line. Triangles will not cross 
a break line in the terrain model. 

Soft Break Line A soft break line is a break line, however, if it crosses a break line, it will not 
affect the triangulation and is ignored. 

Graphic Break Line A soft break line is a soft break line that is not stored in the terrain model. 

Contour  

Element or set of elements of the same elevation. Contours may be used as 
source data to generate a terrain model, or may be computed (i.e., drawn 
based on terrain model). Contour interval is the elevation difference 
between two adjacent contours. 

Hole An area defined by a closed shape that demarcates a region where the 
current terrain is ignored and the underlying terrain is utilized. 

Boundary external boundary of the surface. 

Drape Boundary exterior surface boundary that determines its elevations by draping on the 
underlying surface. 

Void 

An area defined by a closed shape that demarcates a region of missing data 
or obscure areas. No point or break data located within the void area is 
utilized and no triangles are created inside the void areas. The Void 
coordinates are included in the triangulation and void lines between 
successive void coordinates are inserted as drape lines on the surface. 
Therefore, they do not change the slope or elevations of the surface. 

Drape Void 

An area defined by a closed shape that demarcates a region of missing data 
or obscure areas. No point or break data located within the void area is 
utilized and no triangles are created inside the void areas. In the drape void, 
the void coordinates are not included in the triangulation. Voids are 
inserted post triangulation. The void coordinates and lines are draped on 
the TM surface. Even though a user must provide an elevation for Drape 
Void vertices, the user elevations are changed to the elevation of the TM 
surface at the XY Drape Void coordinate position. 
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Break Void 

An area defined by a closed shape that demarcates a region of missing data 
or obscure areas. No point or break data located within the void area is 
utilized and no triangles are created inside the void areas. It differs from 
Voids and Drape Voids in that it utilizes the vertex elevations of the 
graphical element, while the void lines between successive void coordinates 
are inserted as break lines. Therefore, break voids change the slope and 
elevations of the surface. 

Island An area defined by a closed shape that demarcates a region of data wholly 
within a void. Void (islands in the middle of rivers, lakes, etcetera). 

TRIANGULATION OPTIONS - EDGE METHOD 
Several of the terrain model tools utilize the triangulation options section where the Edge Method is 
specified. 

Many of the external edge triangles are thin and narrow and not representative of the surface. This is 
particularly evident where the edge of the data set is concave in nature. One approach to eliminate 
these triangles is the use of the Edge Method. 

None or No 
Removal 

No external triangles are deleted. Note the Maximum Triangle Side Length 
is ignored. There are no user defined parameters 

Remove Slivers 
Long, thin triangles are dissolved based on a formula hard coded within the 
software. Note the Maximum Triangle Side Length is ignored. There are no 
user defined parameters. 

Max Triangle 
Length 

External triangles whose external edge is longer in length than the user 
specified distance are deleted. Note the side option does not apply to 
internal triangles, only those on the edge of the model. Specify the 
Maximum Triangle Side Length in master units. 

 

POINT FILTERING 
Three options are supported: None, Tile, and Tin. From empirical studies, the tiling algorithm is faster 
and typically produces a 30% to 50% reduction in file size. The TIN algorithm typically produces a 70% 
to 90% reduction. 

The tiling algorithm is a recursive divide and conquer algorithm that divides the data set into tiles. A 
best fit plane is calculated for each tile and LIDAR points are removed if they fall within the user set Z 
tolerance to the plane. 

The TIN algorithm filters points if they fall within the user set Z tolerance of the triangle planes. The 
TIN algorithm first tiles the points into tiles with a maximum of 2 million points and then repetitively 
triangulates each tile filtering out points. 

Once the filtering is complete, the Point Features Before Filter, After Filter, and Percentage Reduction 
are displayed in the dialog (read-only). Where multiple data files are loaded the test filter results are 
applicable only to the active selection. 
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Once the option is selected, the input fields change to reflect the selection. Fields common to all 
options are listed below. 

Test Filter 
Once the filter fields are populated, check Test Filter to commence the filter 
routines are populate the Report fields. The fields can be adjusted and 
processed again (if desired) before the data is imported as a surface. 

Source File 
Units 

If the software can determine the units from the data file, this field is 
populated. If it cannot determine the units, Unknown is displayed. The user 
can specify Unknown, Millimeters, Centimeters, Meters, Kilometers, Inches, 
Feet, US Survey Feet, Miles. If Unknown, then the design file units are used. 

NONE 
No filter is applied if None is selected. No additional inputs are required. 

TILE 
The tiling algorithm is a recursive divide and conquer algorithm that divides the data set into tiles. A 
best fit plane is calculated for each tile and points are removed if they fall within the user set Z 
tolerance to the plane. 

Z Tolerance 

The variation in the Z coordinate that the surface is allowed to move during the 
filtering process. Typically for the first invocation of the filtering function, the Z 
tolerance should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 
0.5 for metric data sets. Depending on the outcome and desired result, the Z 
tolerance can be varied up or down. 

Minimum 
Tile Points 

A tile will not be subdivided if it has less than this number of points. Typically 
set this to five. 

Max Tile 
Divisions 

Allowable level of recursion allowed and is the number of times the initial tiling 
set can be subdivided. Typically set this to five. 

Start Tile 
Length 

The data set is initially divided into tiles of this size, prior to recursion to the 
minimum tile points. The setting of this parameter requires some knowledge of 
the distance between the points, which requires an inspection of the points in 
MicroStation to determine. Typically set this to 10 times the distance between 
the points. 

TIN 
The TIN algorithm filters points if they fall within the user set Z tolerance of the triangle planes. The 
TIN algorithm first tiles the points into tiles with a maximum of 2 million points and then repetitively 
triangulates each tile filtering out points. 

Z Tolerance 

The variation in the Z coordinate that the surface is allowed to move during the 
filtering process. Typically for the first invocation of the filtering function, the Z 
tolerance should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 
0.5 for metric data sets. Depending on the outcome and desired result, the Z 
tolerance can be varied up or down. 

Granularity Course - Filters more points with some blurring of ridges and valleys. 
Fine - Filters fewer points with less blurring of ridges and valleys. 
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Glossary 
2D Point Feature Contains no elevation (Z).  2D Point Features are defined and stored in plan model. 

3D Geometry 3D geometry is created in 3D model by mathematically combining the horizontal 
and vertical geometry to create 3D elements.  These 3D geometry elements in turn 
define a design model. 

3D Model This is created and managed automatically.  User can interact with it but this is not 
usually required.  The mathematical combination of Plan Geometry and Profile 
Geometry is stored in the 3D model. 

3D Point Feature 3D points can be defined in plan model or 3D model.  They are stored in 3D model 
but represented in both plan and 3D. 

Active Object The current object to which is added all geometry which is created. 

Active Profile Of the multiple possible profiles for an element, the active profile is the one used 
for design.  The active profile is combined with the horizontal geometry to build a 
3D element which is used in the 3D model. 

Active Terrain 
Model 

One terrain model can be designated as “Active”.  The active terrain model is the 
one used to display “existing ground”; in other words the one which displays 
automatically in a profile model when it is opened.  The active terrain model is also 
the one which is targeted by side slopes unless the template defines a different 
target by name. 

ALG A legacy (proprietary) InRoads file containing coordinate geometry information, 
superelevation, and alignment information for a specific geometry project. 

Alignment A linear feature which serves the special purpose of defining the centerline or 
baseline of a roadway. 

Apply Linear 
Template 

Applies a corridor template along a feature while hiding some of the complexity of 
creating a corridor. 

Apply Surface 
Template 

Applies a corridor template to a terrain model for the purpose of creating 
components (such as pavement layers) under the terrain model. 

Arc Definition Curve definition method generally used in roadway applications. The radius R is 
used to define the curve and is defined by the equation R=5729.58/D where the 
degree of curvature D is the central angle subtended by a 100-foot arc.   Set in the 
Design File Settings > Civil Formatting under Radius Settings.  See also Chord 
Definition.  

Aspect An angular measure of the direction that the face of a surface is oriented. The 
format of the value is dependent on angular settings In the DGN file. 
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Base Geometry In many instances the geometry element will be trimmed. The original (or base), 
untrimmed element is always preserved as it is the storage for the rule. 

Boundary  (Terrain 
Model)  

Used to constrain the external boundary of the terrain model. No triangles are 
created outside the boundary. In addition, any point data outside the boundary is 
ignored. 

Break Line A surface feature consisting of a collection of spatial coordinates that have an 
implied linear relationship. No triangle side (in the triangulated surface) can cross 
over a break line. 

Break Void A closed area of missing or obscured data that uses the elevations of each vertex, 
while the void lines between successive void coordinates are inserted as break 
lines. Therefore, break voids change the slope and elevations of the TIN surface. 

Cardinal Points One of the points used to define the geometry of an alignment. Cardinal points 
include PC, PT, PI, and CC points for horizontal geometry and VPC, VPI and VPT for 
vertical geometry.  

Centroid (triangle) Geometric center of a triangle in a terrain model.  

Chord Definition Curve definition method generally used in railway applications.  The radius R is 
used to define the curve, and is defined by the equation R=50/SIN(0.5*D) where 
the degree of curvature D is the central angle subtended by a 100-foot chord.  See 
also Arc Definition.  

Civil Cell Used as a mechanism to preconfigure commonly used complex geometric layouts.  
These layouts will commonly be stored in DGNLIB files for reuse across multiple 
projects but it is possible and sometimes useful to store directly in an active DGN 
file for use in that single location.  The civil cell will contain horizontal geometry 
and can also contain the vertical geometry. 

Civil Message 
Center 

Used to display a continuous updating log of Civil messages, including warnings 
and errors. As errors and warnings are resolved, they are removed from the list.  
New messages are added whenever the conditions warrant. Most messages relate 
to civil geometry, superelevation, and corridor modeling. 

Civil Template A civil design concept used most often for corridor modeling but also has other 
applications.  The Civil Template defines the cross-sectional shape of the object 
being modeled.  This cross-section is then “extruded along” a 3D geometry 
element to form the final model. The corridor template can create or target 
features such as road edges.  The result is the creation of a corridor. 

Clipping Reference Clipping allows you to remove areas of overlap when working with multiple 
corridors in a single surface.  For example, in a corridor intersected by a crossing 
roadway, clipping would be used to remove all overlapped features within the 
intersection. 

Complex Terrain 
Model A terrain model created by merging or appending two or more terrain models.  
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Context Toolbox When an element is selected, hovering over the element provide a heads-up and 
context sensitive toolbar which pops up at the cursor.  This toolbar provides a few 
of the most commonly used tools which operate on the element selected element 
type. The first tool in this toolbar is always Quick Properties. 

Contour A linear symbol representing points of equal elevation relative to a given datum. 

Contour, Isopach Contours of a delta terrain model which represent cut and fill values as contours, 
not elevations. A positive contour represents fill, while a negative contour is cut.   

Contour, Major The primary elevation line indicating a specific elevation in a surface model. 
Usually major contours are drawn with a heavier line weight or using a different 
color. Elevation text labels are usually drawn in association with major contours. 

Contour, Minor A secondary elevation line indicating a specific elevation in a surface model. Minor 
contours are often drawn without special color or weight indexing and without 
elevation text labels. 

Corridor A civil object used for modeling a roadway and is automatically managed by the 
corridor modeling tools. 

Cross Section 
Model 

DGN models (extracted perpendicular to defined horizontal geometry) with special 
station elevation coordinates defined and other specialized capabilities such as 
view exaggeration. Cross section stations match the interval in the template drop 
when a corridor is used as the basis. When horizontal geometry is utilized, the left 
/ right offsets and interval are user-defined. 

Curve Stroking Stroking is the process of automatically adding shots to the terrain model or 
corridor by interpolating new shots from the curved sections of the data. This 
distance is used to interpolate new shots along the curved element in corridor 
processing and applying linear templates. This value is used as a perpendicular 
minimum distance from chords generated along the arc. Chords are drawn along 
the arc and the perpendicular distance is measured from the middle of each chord 
to the arc. If this distance is larger than the Curve Stroking, the process is repeated 
with a shorter chord length. This process is repeated until the end of the curve is 
reached. The flatter the curve, the fewer number of points will be calculated. The 
steeper the curve, the greater number of points that will be calculated. 

DDB File GEOPAK file (Design DataBase) which contains features definitions, associated 
symbology and annotation settings.  

Delta Terrain 
Model 

A surface containing data derived from the difference in elevation between two 
terrain models or a terrain model and a plane.  

Dialog The tool settings box for the active command.  The dialog shows all available 
options for a command.  For most civil commands, most of the time, the dialog can 
be hidden and ignored since the user is given all necessary instruction and inputs 
by way of the cursor prompt.  The dialog is necessary for configuring command 
customizations. 

Drape The process of vertically projecting elements onto a surface so that the element 
elevations are defined by the surface. 
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Drape Void A closed area of missing or obscured data where the void coordinates are not 
included in the triangulation. Voids are inserted post triangulation. The void 
coordinates and lines are draped on the TIN surface. Even though a user must 
provide an elevation for the Drape Void vertices, the user elevations are changed 
to the elevation of the TIN surface at the XY Drape Void coordinate position. 

Element Template MicroStation concept which allows preconfigured definitions for symbology and 
other miscellaneous display of MicroStation elements and civil features. 

End Condition A specialized component of a corridor template which provides information tie 
into active surface. 

End Condition 
Exception 

Used to modify the behavior of an end condition solution without requiring the 
use of additional template drops.  When an end condition exception is added, it 
must be edited to change its behavior. 

Export to Native Option to automatically or manually push horizontal and vertical geometry into 
native products (InRoads - ALG, MX - PSS and GEOPAK - GPK).   

Feature A Feature is anything that can be seen or located and is a physical part of your 
design, representing a real world thing.   A feature’s definition is one of its 
properties.  At any given time in the design process, the feature will have a 
Horizontal Geometry, a Vertical Geometry, 3D Geometry or a combination to 
define its location. 

Feature Definition Used to define options when creating features.  These are the items which are 
created in advance, usually used across multiple projects and define symbology, 
annotation and quantities.  The feature definition is assigned (usually) in the plan 
model and profile/3D feature definitions follow from there. 

Feature Name Each Feature can have a name. 

Gap When a feature is trimmed the part(s) which are invisible on the base geometry. 

GPK A legacy (proprietary) GEOPAK database containing coordinate geometry 
information. 

Graphical Filter Using in developing terrain models, an automated way of storing search settings 
for graphic elements when creating terrain models using 3D element. A graphical 
filter can be created for each feature (i.e., spots, breaks, voids) then the filters can 
be defined as a Graphical filter group.   

Heads Up  Prompt Command instructions are given in a heads up and dynamic prompt which floats at 
the cursor. 

Horizontal 
Geometry 

The elements which define the horizontal layout of the design.  These elements 
are 2D elements even if the DGN model is 3D. Horizontal Geometry may be points, 
lines, arcs, spirals, splines or any combination in a complex element. 

Interval When a feature is trimmed the part(s) which are visible on the base geometry. 

Island Closed area used to place within a void, i.e., islands in the middle of rivers, lakes, 
etc. 
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Key Station Additional station added to the corridor to force processing at the particular 
location.  

LIDAR (Light Detection And Ranging) is an optical scanning technology which scans 
ground and other physical features to produce a 3D model.  

Linear Feature In plan model, composed of lines, arcs, spirals, splines or combinations of these.  In 
profile model, composed of lines, parabola, splines or combinations of these. 
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	2. Select the MicroStation Sheet model – Simple Drawing.
	This Drawing display the terrain model in the same style as is active in the design model.
	3. Select the Terrain and open Element Information.
	4. Enable Override Symbology.
	5. Select the Terrain and pick Template\Existing Ground.
	6. Apply the Saved View – Depression Contour.
	7. Select from the Terrain Tasks - Label Terrain Contour.
	This MicroStation tool allows manual annotation in areas of specific interest.
	8. Ensure the Terrain Model GROUND is active.
	9. Use the annotation tool to apply specific annotation.
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	Chapter 2: Create from File
	Overview
	Civil Terrain Model – Create from File
	 Exercise: Create a Civil Terrain from a external files
	1. Open the file Chapter 2\Import from file.dgn.
	2. Open Terrain Model Task – Create from File.
	3. Select Chapter 2\LandXML\Main Survey.xml
	The XML we are importing contains the name definition for the resulting surface in the left hand side. If you want to rename the surface, click on the name.
	4. Set the Feature definition to Terrain\General Terrain
	5. Set the Edge Method to No removal.
	6. Import , close the form and fit the view.
	7. Take time to review the available display properties using the Context Toolbar Display Properties


	Updating a Civil Terrain Model
	 Exercise: Update Terrain Source Rule
	1. Open a Windows Explorer view to \Chapter 2\LandXML and run update.bat (Simulating a file revision from Projectwise)
	2. Open Project Explorer and view the Civil model tab.
	3. Expand the Terrain Model’s tree to allow review the stored terrain model.
	4. Right Click on the Rule  ‘From file:…’ and Select ‘Update Terrain Source’.
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	Chapter 3: Reviewing Terrain Models
	Overview
	Reviewing Terrain models
	 Exercise: Reviewing the imported Terrain
	1. Open the file Chapter 3 – Reviewing Terrains.dgn.
	2. Open the command Report Conflicting Points
	3. Follow the heads-up prompts.
	4. In the Terrain Model Report Dialog we have a duplicate point listed. The active point is indicated as – Terrain Point
	5. Right Click  on one of the warnings in the table and select ‘zoom to’
	6. To help understand the terrain the command Analyze Point  can be used to locally investigate the surface
	7. Right Click on the active Terrain point and Delete. This will force use of the higher value and smooth the resulting terrain.
	8. Open the command Report Crossing Features
	9. Follow the heads-up prompts.
	10. In the resulting table view, select the ‘Level Difference’ Header to sort the view and review the identified issues.
	11. Open Saved View 2 - .(the bridge area in the middle of main view)
	12. Turn on the ‘Source Feature Display’ – breaklines. This will help understanding the problem with the Terrain.
	13. Resolve the errors resulting from the inclusion in the surface of the three parallel break line that represent the road surface on a bridge (level difference over 2m) using the right click option Delete Feature. Remember to use undo if unsure
	14. Open Saved view 3
	15. Turn on ‘Breaklines’, ‘Spots’ and ‘Triangles’ to aid the
	16. Open the command Edit Terrain Model
	17. Explore options to improve contours by swapping triangle faces
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	Chapter 4: Appending Terrain Models and Create from ASCII
	Overview
	Appending a Terrain Model from File
	 Exercise: Appending to a terrain
	1. Open the file Chapter 4 – Import from File.dgn.
	2. Create from File
	3. Select the files .\Chapter 4\LandXML\ Phase1 & 2.
	4. We can use the Dialog to process multiple files, either to individual Terrain Models  in the current DGN or by running the command in sequence and appending them together.
	5. Unselect Survey Phase 2 as we will be processing the files seperately.
	6. Change the name of Survey Phase 1 to Survey.
	7. Set the Feature definition to Terrain\General Terrain.
	8. Import and fit View.
	9. Select Survey Phase 2.
	10. Toggle Append to Existing Terrain and pick Survey before importing.
	11. Select the resulting terrain and open Element information to confirm the following surface infromation.


	Appending a Terrain Model from ASCII File
	 Exercise: Appending to a terrain
	1. Select Create Terrain from ASCII Import
	2. Select \ASCII\SPOTS.txt
	We need to load an existing mapping file or create a new one.
	3. Use the Text Import Wizard browse button to load the saved settings file Chapter 4\ASCII\Spot import settings file.xml
	4. Select Edit Settings file from the icons to review them.
	5. Edit the Settings file to review the formatting is correct
	6. Finish the Text Import Settings and save  a new settings file with any changes
	7. Toggle Append to Existing Terrain and pick Survey before importing
	8. Select the resulting terrain and open Element information to note the changes to surface from before.
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	Chapter 5: Create Terrain from Graphical Elements
	Overview
	Creating Terrain Model By Graphical Filters (bulk import)
	 Exercise: Creating Terrain models by Graphical Filters
	1. Open Chapter 5 – Import from Graphics.dgn.
	2. Select the Terrain Modeling task Create Terrain by Graphical Filters
	3. Select  Graphical Filter Group – Bulk Import from Graphics and preview
	4. In the form Ensure the following settings
	i. Edge Method = Remove Slivers
	ii. Terrain Features  Feature Definition = General Terrain
	iii. Name Prefix = Survey
	5. Follow the on screen prompts to confirm and accept the import.


	Creating Graphical Filters
	 Exercise: Creating Graphical Filters
	1. Select Graphical Filter Manager
	2. Expand the tree view to review the stored Filters and Filter Groups.
	3. In Level Display – Enable the level Spot Height
	4. Zoom in and select a point In the drawing select an element representing the Spot features - Ref3:Surevey Phase3 Ground model
	5. In the Graphical Filter Manager select Create Filter by Selection Set
	Edit Filter allows you to review all the display properties for the current Selection. These filters properties can be wild card or explicit based on multiple properties.
	6. Preview to ensure all the random spots are selected before Finish.
	7. Under Filter Properties enter Name = Random Spots
	8. Feature Type = Spot
	9. Select the Graphical Filter Group – Bulk Import from Graphics
	10. Add the newly created Random Spots filter and Finish.
	11. In Project Explorer for the Survey Update Terrain Source


	Adding Elements to a Terrain Model
	 Exercise: Manually adding graphical elements into Terrain models
	1. Select all the elements on the level Buildings
	2. Select Terrain Task – Add Features
	3. Select Survey as the Terrain model
	4. Select Void as the feature type
	5. Accept the command to add the buildings as voids.
	6. Zoom into one of the buildings to confirm it has no triangles crossing it.
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	Chapter 6: Create from Point Cloud
	Overview
	Creating a Terrain Model By Point Cloud
	 Exercise: Creating Terrain models from a Point Cloud
	1. Open Chapter6\Point Cloud.dgn
	The point cloud has already been attached. Take a moment to review the View Attributes to look at the point cloud.
	2. Select the Terrain Model task Create by Point Cloud
	3. Before testing the Filter Select
	4. Select the Feature as Large Terrain (to display just as the Terrain Boundary)
	5. Set Edge Method to Remove Slivers and Import.
	6. Turn on Contours for the resulting Terrain to validate the surface.
	7. Turn off the Point Cloud’s display under File > Point Clouds.


	Analyze Volumes
	 Exercise: Analyze Volumes from multiple Terrain Models
	1. Open Chapter6\Volumes.dgn
	2. Select the Terrain Model task Create Analyze Volumes
	3. Follow the heads-up prompts.
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	Chapter 7: Creating a Complex Terrain Model
	Overview
	Creating a Complex Terrain Model
	 Exercise: Creating a Complex Terrain Model
	1. Open Chapter 7\Complex Terrain.dgn
	2. Select the Terrain Model command Create Complex Terrain Model.
	3. Add the models and the method as indicated below.
	4. Set the Feature Definition to Existing Terrain.
	5. Set Name Prefix to Ground.
	6. Apply and inspect the finished terrain.
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	Chapter 8: Clipping Terrains to Corridors
	Overview
	Clipping a Terrain Model to a Corridor
	 Exercise: Clipping Terrain to Corridor Objects
	1. Open Chapter 8\Clipped.dgn
	The model is made up of the following references
	2. Select the Terrain Model command Create Clipped Terrain Model.
	3. Follow the heads-up prompts.
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